Private Wells in New Jersey: Building Local Health Capacity

Presenters:
Jessie Gleason, MSPH
New Jersey Department of Health

Rebecca Schwartz
New Jersey Department of Health
Presentation Agenda

• Needs Assessment Findings

• Private Well Water Regulations in NJ

• Specific Contaminants of Concern
  • Coliform
  • Gross Alpha
  • Arsenic

• Water Treatment Financing Programs

• Public Notification: Neighbors Outreach

• Identification of Neighbors: Tips & Tools
Centers for Disease Control and Prevention (CDC) Support

- **Perform targeted outreach efforts**: neighbor-based, school-based, communities & healthcare-based
- **Develop guidance** that can be utilized by local health departments
- **Provide local health department funding**
  - **$5,000 awards** to support private well outreach
  - NJ SAGE
  - Estimated funding opportunity announcement October/November Up to three LHD awards available over the next four years (dependent on funding availability)
Private Wells in New Jersey

- Most densely populated state in U.S.
- About 11-13% of NJ residents on private well water, about 1 million people
- Estimated 400,000 wells used for water consumption purposes
- No federal regulations - unregulated under 1974 Safe Drinking Water Act
Needs Assessment Findings

• Limited survey to LHD attendees at 2016 NJ NEHA meeting
  • Included representatives from 11 LHDs that serve private well users

- Staffing shortages and heavy workloads identified as barriers to LHD private well programs
- Respondents were asked whether they conduct outreach when the PWTA identified a problem
  - 50% responded ‘Yes’
  - 50% responded ‘No’

Do you think your health department does a good job assisting private well users?

- VERY GOOD: 42%
- GOOD: 25%
- FAIR: 25%
- POOR: 0%
- VERY POOR: 8%
Needs Assessment Findings: LHD Training for Private Wells

What would be the best way to receive training?

- Webinars: 8
- Conferences: 7
- Online tutorials: 7
- Hard Copy: 4
- Other: 2

What type of training would be most useful?

- Water treatment: 8
- Outreach: 8
- Risk communication: 6
- Interpreting test results: 6
- Other: 1
What are the most important private well contaminants of concern in your service area?
Percentage of Most Prevalent Contaminants Exceeding MCLs in Private Wells

- Gross Alpha: 10.1%
- Arsenic: 8.9%
- Nitrates: 2.7%
- FC / E.Coli: 2.1%
- VOCs: 1.2%
- Mercury: 0.9%

Legend:
- Naturally Occurring Elements
- Anthropogenic Sources
How frequently do you receive questions from private well users?
Private Well Water Regulations in NJ
NJ Private Well Testing Act (NJ PWTA)

- Adopted September 2002
- Consumer Information law
- Requires buyer or seller of property with a private well to test untreated water
- Landlords required to test wells every 5 years
- Confidential
- Certified laboratories submit water results electronically to NJDEP
- Some water quality parameter requirements are specific to geographic location (North v. South Jersey)
- ~100,000 (25%) wells test results reported

https://www.state.nj.us/dep/watersupply/pw_pwta.html
Private Well Testing Act Rules

• Sample collection and analysis must be performed by a PWTA certified lab
  • List of labs available at NJDEP Data Miner
    https://www13.state.nj.us/DataMiner

• Laboratory must follow reporting rules using standard form and must report to NJDEP electronically
  • Analytical results are valid for 1 year
  • Coliform results valid for 6 months

• Raw water samples (pressure tank or bypass treatment and sample at kitchen sink)
  • Lead sampling requires 2-minute flush

• Laboratory must notify person requesting the test and local health department of a violation within 24 hours from obtaining results

• NJDEP shall notify LHD of violation within 5 business days after receiving notice
# PWTA Required Parameters

## Primary Drinking Water Contaminants

<table>
<thead>
<tr>
<th>Bacteriological: Total Coliform (E. Coli or Fecal)</th>
<th>Presence/Absence</th>
</tr>
</thead>
<tbody>
<tr>
<td>29 Volatile Organic Compounds (VOCs)</td>
<td>MCLs vary</td>
</tr>
<tr>
<td>Inorganic Compounds: Arsenic</td>
<td>5 µg/L</td>
</tr>
<tr>
<td>Lead</td>
<td>5 µg/L</td>
</tr>
<tr>
<td>Mercury</td>
<td>2 µg/L</td>
</tr>
<tr>
<td>Nitrates</td>
<td>10 mg/L</td>
</tr>
<tr>
<td>Radiological:</td>
<td></td>
</tr>
<tr>
<td>Gross Alpha</td>
<td>15 pCi/L</td>
</tr>
<tr>
<td>Uranium*</td>
<td>30 µg/L</td>
</tr>
<tr>
<td>Radium (226+228)</td>
<td>5 pCi/L</td>
</tr>
</tbody>
</table>

## Secondary Drinking Water Contaminants

| pH                                               | 6.5-8.5          |
| Iron                                             | 0.3 mg/L         |
| Manganese                                       | 0.05 mg/L        |

## Abbreviations

- **MCL** = Maximum Contaminant Level
- **SMCL** = Secondary Maximum Contaminant Level
- **ml** = milliliters
- **pCi/L** = picocuries per liter
- **µg/L** = micrograms per liter
NJ MCLs developed for PFNA, PFOA and PFOS

<table>
<thead>
<tr>
<th>PFAS</th>
<th>MCL</th>
</tr>
</thead>
<tbody>
<tr>
<td>PFNA</td>
<td>13 ppt</td>
</tr>
<tr>
<td>PFOA</td>
<td>14 ppt</td>
</tr>
<tr>
<td>PFOS</td>
<td>13 ppt</td>
</tr>
</tbody>
</table>

parts per trillion (ppt) = Nanogram/Liter (ng/L)

Testing for PFAS required under NJ PWTA - December 2021

Frequently Asked Questions (FAQs)

How much will the testing cost?
- Currently, $650 - $750.
- With PFAS included, around $1,000

What is the cost of water treatment?
- It depends on contaminant. Potable water loan available (0% interest)

How do I know what water treatment is suitable?
- Contact a local water treatment consultant if you are unsure about appropriate water treatment. Water treatment professionals are not certified.

Is the water safe to bathe/shower in?
- It depends (arsenic and VOCs above MCL not recommended for bathing/showering).

Does boiling/cooking water get rid of the contaminants?
- No – can cause contaminants to concentrate even more.

https://www.state.nj.us/dep/watersupply/pwta/pwta_faq.htm
NJ PWTA Data Summary

https://njdep.maps.arcgis.com/apps/MapSeries/index.html?appid=826ec9fae77543caa582a787d5f088e7

- Data summarized by county, municipality and 2x2 mile grids
- Address location feature allows pinpoint to grid

Legend
% of Wells Exceeding MCL (> 15 pCi/L)

- Less than 10 wells sampled
- No wells
- 0 – 15 %
- 15 – 30 %
- 30 – 45 %
- 45 – 60 %
- 60 – 76.8 %

Legend
% of Wells Exceeding MCL (> 5 µg/L)

- Less than 10 wells sampled
- No wells
- 0 – 15 %
- 15 – 30 %
- 30 – 45 %
- 45 – 60 %
- 60 – 76.8 %
NJ Safe Drinking Water Act

• New wells: requires conditional “certification” from LHD before drilling begins (or alteration)

• Upon completion of new well – the owner must have a state-certified laboratory test the water for contaminants and submit results to local health agency

• Local health agency may require “physical and chemical treatment”

• Local health agency shall require treatment when
  • (1) water does not meet the primary drinking water standards
    • (2) water exceeds the secondary drinking water standard
  • Local health agency finalizes certification after well is constructed and tested.

• Pursuant to SDWA, New Jersey Housing and Mortgage Finance Agency provides 0% loans for treatment
New Jersey Subsurface and Percolating Waters Act

• Only professionals licensed by DEP and the State Well Drillers and Pump Installers Examining Board are authorized in installing, servicing, repairing and decommissioning residential wells and pumping equipment
  • Well drillers are specifically authorized to install, maintain, and replace treatment equipment located between a well and storage tank
  • A master well driller has authority to certify that a well – including any related treatment – has been constructed in accordance with state standards
• Establishes construction standards for wells, and minimum distance requirements from buildings, sewers, septic tanks, and fuel storage tanks, among other things
Water Treatment Regulations

- There are no regulations for treatment professionals, only regulations regarding treatment installation are in the plumbing code
- State plumbing license law of 1968
  - “Master plumber” requires valid license
  - Plumbing license is required to install or disconnect “water filtration or softening equipment”
Local Ordinances

• Hopewell Twp., Mercer County
  • Requires two-tank arsenic treatment if PWTA results exceed NJ arsenic MCL

• Cumberland County Health Department
  • Ordinance #12
  • Requires water certification before Certificate of Occupancy can be issued and for rental licenses
  • Original lab results (initial and/or retest) presented to CCHD - all PWTA required parameters must pass standards
  • Certificate issued for a fee paid to CCHD

Extra credit for information on other local ordinances
(add to chatbox or send me an email)
Specific Contaminants of Concern
Private Well Sources of Contamination

Naturally occurring sources:
• Private wells drilled into bedrock units
  • Underlying bedrock geology (e.g. - arsenic, gross alpha, uranium, radium)
  • Leaches into water through – construction of new well, drilling, and/or fractured bedrock units
• Other contributing factors: age, depth, and type of well

Anthropogenic sources:
• Agricultural and lawncare – nitrates
• Septic tanks – microorganisms
  • Minimum of 100-foot separation of leach fields and septic tanks from well
• Air pollution
• Industrial discharge
Coliform Bacteria

• Required PWTA testing statewide in NJ
  • Results are good for 6-months if using for PWTA
• Total coliform (TC) - "indicators" for possible disease-causing microorganisms
• Sources: septic tanks, contaminated surface waters, stormwater runoff, damage to well head such as a broken well cap, etc.
• Colilert – simultaneously determines presence of coliform and E.Coli – no confirmation test needed
• Test annually
• Water treatment: Ultraviolet light or chlorination
  • Additional Resources – Penn State Extension:
    • https://extension.psu.edu/colliform-bacteria
    • https://extension.psu.edu/shock-chlorination-of-wells-and-springs
TC/EC Recommendations:

• If (TC + / EC +) stop drinking water
• If (TC +/- EC -) or (TC +/ EC +) the following steps may be useful:

1. Retest immediately (ASAP, < 1 week); test again in 6 months
2. Ongoing (+) test results require removal of surface contamination source(s), remedy of well construction defects (Does rainfall surface runoff impact the wellhead area? Is there a septic tank leach field near by with potential impact? Are there pet and/or farm animal wastes near the wellhead?)
3. If unable to find an issue, have well inspected by certified well professional
4. If still unable to find an issue, install certified UV disinfection system or install a new well
5. Shock chlorination may be appropriate if the source of your contamination is nearby and likely due to a one-time event (e.g., a neighbor drilled into the same aquifer and you’re downstream, hurricane and extreme flooding or maintenance on a well that could have introduced bacteria)
6. After two weeks retest to ensure corrective actions have remedied the issue
Gross Alpha
Background Information

• Gross alpha is a measurement of radioactivity in drinking water
  • MCL: 15 pCi/L
• Naturally occurring
• North vs. South Jersey
  • North – Uranium, lesser extent radium
  • South – Radium
• Odorless, colorless, tasteless
• Adverse health effects
  • Radium – bone and sinus cancer
  • Uranium – kidney toxicity
• Requires a 48-hour test
Radioactive Elements and Isotopes

- Radioactivity (i.e., gross alpha) in drinking water is caused by elements such as radium and uranium
- Radium: MCL of 5 pCi/L
  - If gross alpha > 5 pCi/L but < 15 pCi/L additional testing for combined isotopes radium-226 (Ra-226) + radium-228 (Ra-228) recommended
  - 48-hour gross alpha test captures Ra-224 (half-life < 4 days)
- Uranium: MCL of 30 µg/L or ppb
  - Naturally occurring isotopes: uranium-234 (U-234) and/or uranium-238 (U-238)
Gross Alpha Water Treatment Options

**Radium (Positive Charge +)**

- Water softener
  - $1200 - $1500
- POU Reverse Osmosis
  - $800

**Uranium (Negative Charge -)**

- Anion Exchange (followed by pH neutralizer)
  - $2000
- POU Reverse Osmosis
  - $800
Radioactivity in Drinking Water Guides

• How and why radioactivity affects private wells
• Risks of radioactivity
• Testing procedures
• Ways to reduce radioactivity

North Jersey Guide: https://www.state.nj.us/dep/rpp/rms/agreedown/urwater.pdf
Arsenic Background Information

• Inorganic arsenic – naturally occurring or anthropogenic
• Very prevalent in NJ Piedmont Province
  • Pyrite found in black shale
  • Hematite and clay minerals from red shale
• Potential chronic drinking water exposure effects: variety of cancers (skin, lung, urinary bladder, etc.), diabetes
• Exposure routes: ingestion and dermal
• Odorless, colorless, tasteless in drinking water
• Only way to detect arsenic – test your water!

NJ Arsenic Standard

- Current federal standard: 10 µg/L
- Current NJ arsenic standard: 5 µg/L
  - Both became effective in January 2006
  - New Jersey and New Hampshire - most protective standard

- Prior, standard was 50 µg/L
- Maximum contaminant level goal (MCLG) of 0 µg/L
Common complications/issues with arsenic removal

• Two inorganic species: As III (arsenite) and As V (arsenate)
  • Different species – limited testing availability from commercial labs
    • Arsenic speciation cartridges
• Typical water treatment (water softener or anion exchange) will **NOT** remove As III from drinking water
• Possible indicators of presence of As III:
  • dissolved iron (> 100 µg/L)
  • manganese (> 50 µg/L)
  • sulfur odor
• pH can negatively impact water treatment
• Two-tank arsenic treatment system recommended in NJ
Recommended Arsenic Water Treatment
Pre Sediment Filter

Arsenic Worker Tank

Arsenic Safety Tank
## Arsenic Water Treatment Options

<table>
<thead>
<tr>
<th>Treatment Type</th>
<th>Preferred Treatment</th>
<th>Process / Maintenance</th>
<th>Chemical Use</th>
<th>Waste Generated</th>
<th>Arsenic Species Removed</th>
<th>Typical Media Life</th>
<th>Average Installation Cost</th>
</tr>
</thead>
<tbody>
<tr>
<td>Whole-House Adsorption</td>
<td>1st Choice</td>
<td>Simple</td>
<td>None</td>
<td>Low</td>
<td>As3 &amp; As5</td>
<td>2-3 years</td>
<td>$2,495</td>
</tr>
<tr>
<td>Point-of-Use Adsorption</td>
<td>2nd Choice</td>
<td>Simple</td>
<td>None</td>
<td>Low</td>
<td>As3 &amp; As5</td>
<td>2-3 years</td>
<td>$835/Unit</td>
</tr>
<tr>
<td>Whole-House Anion Exchange</td>
<td>No</td>
<td>Complex</td>
<td>Salt</td>
<td>High</td>
<td>As5 Only</td>
<td>10 years</td>
<td>$2,000</td>
</tr>
<tr>
<td>Point-of-Use Reverse Osmosis</td>
<td>No</td>
<td>Moderate</td>
<td>Disinfectant</td>
<td>Low</td>
<td>As5 Only</td>
<td>3 years</td>
<td>$835/Unit</td>
</tr>
</tbody>
</table>
Arсеничная весть

http://njarsenic.superfund.ciesin.columbia.edu/

**Website Features:**
- Ключевые факты об арсеновом облучении
- Здоровые риски
- Информативные видео
- Тестирование и лечение

**Additional Resources:**
-Подробные арсеновые обработки

https://www.youtube.com/watch?v=xH8v2mZeVYQ
Water Treatment Financing Programs
Water Treatment Financing: New Jersey Housing and Mortgage Finance Agency (NJHMFA)

- **Eligibility:**
  - Individual private well homeowners only
  - Violations of state Primary Drinking Water Standards
  - Some secondary Drinking Water Standards included

- **Maximum loan amount:** $10,000:
  - 0% no-interest
  - 10-year maximum term

- Potable Water Fact Sheet: [https://www.state.nj.us/dca/hmfa/consumers/docs/ho_potablewater_fs.pdf](https://www.state.nj.us/dca/hmfa/consumers/docs/ho_potablewater_fs.pdf)
Water Treatment Financing: NJ Spill Compensation Fund

• Compensation for damage caused by discharge of hazardous substances (manmade chemicals)

• Qualifications:
  • Requires certified laboratory test: initial and confirming
  • Eligible claim applicable if initial and confirmation results exceed drinking water standards
  • More complicated damages must include evidence/documentation
  • Claims may be eligible for:
    • Installation of water treatment
    • Confirmation test fee
    • Connection to public waterline

• Contact Environmental Claims Administration (ECA) to file a claim
  • URL for claim forms: https://www.nj.gov/dep/srp/finance/ecaclaim.htm

• Claims must be filed within one year from date of damage discovery

https://www.nj.gov/dep/srp/finance/spillfund/spillfund_faqs.htm
Public Notification: Neighbor Outreach
NJ PWTA Public Notification

• Local health department is

  “authorized to issue a public notice to owners of property within vicinity of the subject property suggesting or recommending that property owners may wish to have nearby wells sampled for the failed parameter(s)”

• The specific address or location of the failed private well shall not be identified
• Notification shall be made at a minimum of 200ft
• Public notification at sole discretion of local health authority
Does your department conduct any neighbors outreach?
Demonstration Example #1: Statewide PWTA Neighbors Arsenic Outreach

• Targeted PWTA arsenic neighbors
  • Distance: < 500 ft., 500 – 1,000 ft.
• Invitation letters sent to 1,743 private well homeowners
• Free arsenic test kit mailed to participants (n=274)
• Wells tested: n=214
• 70% of wells previously untested
## Arsenic Results – Distance from Neighbors Well

<table>
<thead>
<tr>
<th></th>
<th>All Wells</th>
<th>Within 500 ft.</th>
<th>500 – 1,000 ft.</th>
</tr>
</thead>
<tbody>
<tr>
<td># of raw samples</td>
<td>214</td>
<td>151</td>
<td>60</td>
</tr>
<tr>
<td>Max. Arsenic Level (µg/L)</td>
<td>66.0</td>
<td>66.0</td>
<td>14.4</td>
</tr>
<tr>
<td>% Exceeding MCL (&gt; 5 µg/L)</td>
<td>26.2% (n=56)</td>
<td>33.8% (n=51)</td>
<td>8.3% (n=5)</td>
</tr>
</tbody>
</table>

Flanagan, S., et al. (2020) *Summary of arsenic results by distance to neighbor's well*
Risk Communication Language

• Three risk version outreach letters sent out, “A well in your neighborhood with arsenic at levels:

  • Low (5 – 10 µg/L): above the standard..."

  • Medium (10 – 25 µg/L): several times higher than..."

  • High (> 25 µg/L): 5 times higher than..."

• Homeowners receiving high risk letters
  • More likely to request arsenic test kit compared to low-risk letters (17.4% vs. 12.8%)
  • And higher participation (14.9% vs. 10.5%)
Demonstration Example #2: Gross Alpha PWTA Neighbors

• Targeted neighbors of high PWTA (> 100 pCi/L) gross alpha homes within 500 foot-distance

• 412 neighbors identified and 5 high gross alpha wells confirmed

• Free testing for 75 wells

• Contaminants tested:
  • Raw water - gross alpha (map), radium, uranium, radon, iron
  • Treated water – gross alpha

Legend

<table>
<thead>
<tr>
<th>Color</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&lt; 15 pCi/L</td>
<td>&lt; 15 pCi/L</td>
</tr>
<tr>
<td>&gt; 15 pCi/L</td>
<td>&gt; 15 pCi/L</td>
</tr>
</tbody>
</table>
## Raw Water Results:

<table>
<thead>
<tr>
<th></th>
<th>Gross Alpha (&gt; 15 pCi/L)</th>
<th>Iron (&gt; 300 µg/L)</th>
<th>Radium (&gt; 5 pCi/L)</th>
<th>Radon (&gt; 800 pCi/L)</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>All</strong></td>
<td>52 (69%)</td>
<td>13 (17%)</td>
<td>43 (59%)</td>
<td>20 (27%)</td>
</tr>
<tr>
<td><strong>North</strong></td>
<td>12 (55%)</td>
<td>1 (5%)</td>
<td>3 (14%)</td>
<td>19 (86%)</td>
</tr>
<tr>
<td><strong>South</strong></td>
<td>40 (76%)</td>
<td>12 (23%)</td>
<td>40 (78%)</td>
<td>1 (2%)</td>
</tr>
</tbody>
</table>
Gross Alpha Neighbors – Drinking Water Exposure

Tested
n = 75

Pass
n = 56
(< 15 pCi/L)

No Treatment
n = 7

Treatment
n = 49

Fail
n = 19
(> 15 pCi/L)

No Treatment
n = 6

Treatment
n = 13
Neighbors Outreach – Summary

• Lack of awareness of widespread arsenic and gross alpha occurrence in local regions
• Outreach to neighbors is effective at identifying contaminated wells
• Recommend outreach to neighbors within 500 ft
  • Percentage of high exceeding wells increases with proximity
  • Highest exceeding neighbor wells > 200ft
• Appropriate high-risk messaging improves participation
• Discrepancies among high PWTA gross alpha value, confirming high PWTA wells prior to selecting neighbors may be useful.
Identification of Neighbors: Tips & Tools
Does your department use mapping software?
Identification of High-Risk Neighbors

• PWTA data to identify high exceeding wells
  • NJDEP -> County Health Department
  • If you are not getting the data you can reach out to Richard.Gunosky@dep.nj.gov

• Geographic Information Systems (GIS) ArcMap
  • Software program used for spatial and geographic data analysis

• Map
  • Wells may have incorrect X,Y values – check these first

• Select neighbors within buffer radius of choice (e.g., 200, 500, 1000ft)
Removing specific properties

• Parcel data includes mailing addresses, property location (sometimes can be different from street address) – does the person really live here?

• Specific properties removed prior to selecting neighboring homes for outreach
  • Churches, farms, schools, etc.
  • Double check building descriptions (BLDG_DES) to check whether they're a house or not
  • Low property values (e.g. - below $1,000)
  • Addresses with a P.O. box address
  • Zip codes from other states
  • May need to remove duplicate addresses
Buffers surrounding Neighbor Parcel Data (Highlighted in Green)
Notification Letters Sent Out

- Letters addressed to resident name of neighboring homes
- Dear "Resident Name or Current Resident"
  - Current resident also addressed
  - New homeowner could be residing in home
- Free water test opportunity outlined in letters
- Registration link also outlined in letters
Please complete a brief survey – we will use your response as attendance record for Public CE credits.

**Link to survey:** [http://healthsurveys.nj.gov/NoviSurvey/n/zz2km.aspx](http://healthsurveys.nj.gov/NoviSurvey/n/zz2km.aspx)

Special thanks to Dr. Steve Spayd, Dr. Nick Procopio, Heidi O’Neill and Dr. Sara Flanagan

For questions about anything discussed today contact jessie.gleason@doh.nj.gov
Step by Step GIS Instructions for Neighbor Identification
Upload New Jersey Imagery

• Enter NJ Geographic Information Network → Imagery

• Under "Streaming", find desired imagery map and click on "ArcGIS REST"

• Open in ArcGIS Desktop

https://njgin.nj.gov/njgin/edata/imagery/index.html#!/
Upload New Jersey Parcel Data

- Click on "Parcel Data" in NJ Geographic Information Network

- Under "Downloads" click "Statewide Parcels Joined with MOD-IV Download"

- Place data in appropriate folder and extract data ("Extract All...")

https://njgin.nj.gov/njgin/edata/parcels/index.html#!
Upload New Jersey Parcel Data

- In ArcMap, click File → Add Data → Add Data...

- Add Parcels_MOD4_Statewide.gdb
2015 Imagery Map

Parcel Data
GIS: Inserting "Corrected" X & Y Data

• Add Excel Spreadsheet **only** with PWTA exceedances
  • Data contains X and Y coordinates
  ** Make sure Excel spreadsheet saved as Comma Delimited (*.csv)

Projected Coordinate System:
NAD_1983_StatePlane_New_Jersey_FIPS_2900_feet
Geographic Coordinate System: GCS_North American_1983
GIS: To create a buffer...

- Go to ArcToolBox
  - Analysis Tools → Proximity → Buffer
GIS: To create a buffer...

- Identify input feature (PWTA point buffer will surround)
- Output Feature Class:
  - Folder location
  - Saved as a shapefile (.shp)
- Identify the buffer of choice (250, 500, etc…)
  - Select Unit (e.g. feet)
GIS: Intersecting buffer to parcel data

- Buffer intersects the parcel
- How to obtain neighbor identification with certain proximity
Buffers surrounding high contaminant wells
Export Data

- Right click buffer intersect shapefile and click "Open Attribute Table"

- In left hand corner, click export and save table as a Excel file
Neighbor's block and lot data (Buffer Intersect)

<table>
<thead>
<tr>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
<th>E</th>
</tr>
</thead>
<tbody>
<tr>
<td>Shape_Leng</td>
<td>PAMS_PIN</td>
<td>PCL_MUN</td>
<td>PCLBLOCK</td>
<td>PCLLLOT</td>
</tr>
<tr>
<td>3141_625844</td>
<td>0105_2235_7</td>
<td>1108</td>
<td>4235</td>
<td>3</td>
</tr>
<tr>
<td>3141_625844</td>
<td>0105_2235_2</td>
<td>1108</td>
<td>4235</td>
<td>5</td>
</tr>
<tr>
<td>3141_625844</td>
<td>0105_2235_4</td>
<td>1108</td>
<td>4235</td>
<td>7</td>
</tr>
<tr>
<td>3141_625844</td>
<td>0105_2235_5</td>
<td>1108</td>
<td>4235</td>
<td>12</td>
</tr>
<tr>
<td>3141_625844</td>
<td>0105_2235_11</td>
<td>1108</td>
<td>4235</td>
<td>17</td>
</tr>
<tr>
<td>3141_625844</td>
<td>0105_2235_12</td>
<td>1108</td>
<td>4235</td>
<td>110</td>
</tr>
<tr>
<td>3141_625844</td>
<td>0105_2235_3</td>
<td>1108</td>
<td>4235</td>
<td>112</td>
</tr>
<tr>
<td>3141_625844</td>
<td>0105_2235_1</td>
<td>1108</td>
<td>4235</td>
<td>2</td>
</tr>
<tr>
<td>3141_625844</td>
<td>0105_2235_8</td>
<td>1108</td>
<td>4235</td>
<td>18</td>
</tr>
<tr>
<td>3141_625844</td>
<td>0105_2235_9</td>
<td>1108</td>
<td>4235</td>
<td>24</td>
</tr>
<tr>
<td>3141_625844</td>
<td>0105_3522_11</td>
<td>1108</td>
<td>4132</td>
<td>23</td>
</tr>
<tr>
<td>3141_625844</td>
<td>0105_3522_1</td>
<td>1108</td>
<td>4132</td>
<td>115</td>
</tr>
<tr>
<td>3141_625844</td>
<td>0105_3522_9</td>
<td>1108</td>
<td>4132</td>
<td>4</td>
</tr>
<tr>
<td>3141_625844</td>
<td>0105_3522_3</td>
<td>1108</td>
<td>4132</td>
<td>6</td>
</tr>
<tr>
<td>3141_625844</td>
<td>0105_3522_5</td>
<td>1108</td>
<td>4132</td>
<td>9</td>
</tr>
<tr>
<td>3141_625844</td>
<td>0105_3522_10</td>
<td>1108</td>
<td>4132</td>
<td>14</td>
</tr>
<tr>
<td>3141_625844</td>
<td>0105_3522_17</td>
<td>1108</td>
<td>4132</td>
<td>118</td>
</tr>
<tr>
<td>3141_625844</td>
<td>0105_3522_12</td>
<td>1108</td>
<td>4132</td>
<td>29</td>
</tr>
<tr>
<td>3141_625844</td>
<td>0105_3522_2</td>
<td>1108</td>
<td>4132</td>
<td>27</td>
</tr>
<tr>
<td>3141_625844</td>
<td>0105_3522_3</td>
<td>1108</td>
<td>4132</td>
<td>1</td>
</tr>
<tr>
<td>3141_625844</td>
<td>0105_3522_19</td>
<td>1108</td>
<td>4132</td>
<td>29</td>
</tr>
<tr>
<td>3141_625844</td>
<td>0105_3522_6</td>
<td>1108</td>
<td>4132</td>
<td>25</td>
</tr>
<tr>
<td>3141_625844</td>
<td>0105_4217_2</td>
<td>1108</td>
<td>6912</td>
<td>17</td>
</tr>
<tr>
<td>3141_625844</td>
<td>0105_4217_4</td>
<td>1108</td>
<td>6912</td>
<td>10</td>
</tr>
<tr>
<td>3141_625844</td>
<td>0105_4217_9</td>
<td>1108</td>
<td>6912</td>
<td>4</td>
</tr>
<tr>
<td>3141_625844</td>
<td>0105_4217_6</td>
<td>1108</td>
<td>6912</td>
<td>116</td>
</tr>
<tr>
<td>3141_625844</td>
<td>0105_4217_3</td>
<td>1108</td>
<td>6912</td>
<td>5</td>
</tr>
<tr>
<td>3141_625844</td>
<td>0105_4217_13</td>
<td>1108</td>
<td>6912</td>
<td>12</td>
</tr>
<tr>
<td>3141_625844</td>
<td>0105_4217_17</td>
<td>1108</td>
<td>6912</td>
<td>109</td>
</tr>
<tr>
<td>3141_625844</td>
<td>0105_4217_1</td>
<td>1108</td>
<td>6912</td>
<td>2</td>
</tr>
<tr>
<td>3141_625844</td>
<td>0105_4217_6</td>
<td>1108</td>
<td>6912</td>
<td>3</td>
</tr>
</tbody>
</table>
Removing specific properties

• Parcel data includes mailing addresses, property location (sometimes can be different from street address) – does the person really live here?

• Specific properties removed prior to selecting neighboring homes for outreach
  • Churches, farms, schools, etc.
  • Double check building descriptions (BLDG_DES) to check whether they're a house or not
  • Low property values (e.g. - below $1,000)
  • Addresses with a P.O. box address
  • Zip codes from other states
  • May need to remove duplicate addresses
Table to Table Join

- ArcToolBox → Conversion Tools → Geodatabase → Table to Table Join
- Table to Table join – Neighboring worst wells with PAMS PIN
Buffers surrounding Neighbor Parcel Data (Highlighted in Green)
GIS Results

• Use identify tool to click on parcel and find address associated with parcel

• Neighbor parcels highlighted

• Selected neighbors and their addresses entered into Excel spreadsheet